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Abstract: 8 

Building evolutionary trees can be an excellent way for students to see how different gene 9 

sequences or organisms are related to one another. Molecular Evolutionary Genetics Analysis 10 

(MEGA) software is a free package that lets anyone build evolutionary trees in a user-friendly 11 

setup. There are several different options to choose from when building trees from molecular 12 

data in MEGA, but the most commonly used are Neighbor-Joining and Maximum – Likelihood, 13 

both of which give good estimates on the relationship between different molecular sequences. 14 

In this article, we describe how to collect data from GenBank, insert it into a text editor, import 15 

that data into MEGA, and create phylogenetic trees from the collected data.  16 

 17 
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 19 

Phylogenetics is the study of the evolutionary relatedness between different groups of 20 

organisms (Nei and Kumar 2000). These groups can be on small scales (e.g., mammals) or large 21 

http://www.nabt.org/
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scales (e.g., different domains of life). The results of phylogenetic analyses are usually 22 

presented in the form of evolutionary trees, where different branches represent different gene 23 

sequences or species used to build them. The branching pattern of the tree illustrates how the 24 

sequences or species are related. 25 

Here we present how to build evolutionary trees using the MEGA software package (newest 26 

version 7; www.megasoftware.net). It contains two of the most commonly used methods to 27 

infer evolutionary relationships among species by using their gene sequences. In this paper, we 28 

will introduce students to these two methods: Neighbor-Joining (NJ) and Maximum-Likelihood 29 

(ML) method.  According to MEGA authors, it is frequently used in educational setting in 30 

advanced classes (pers. comm. Sudhir Kumar; Ryan et al. 2013). However, many K-12 31 

instructors are not familiar with it, and its potential to introduce the concepts of evolutionary 32 

biology to students in a hands-on, discovery-based pedagogy using the gene sequences. There 33 

are multiple online resources that provide such gene sequences for a multitude of species (e.g., 34 

GenBank), which is available from National Center for Biotechnology Information (NCBI) (Hall 35 

2013). Both DNA and protein sequences are available, and there are several informative 36 

tutorials provided on the NCBI website on how to use these. There is literally unlimited 37 

sequence data from thousands of genes from animals, plants, protists, bacteria, and viruses 38 

available through GenBank.  39 

Project Goal: 40 

To build an evolutionary tree using the rcbL gene sequence, which is commonly used to study 41 

the evolutionary relationships between plants (see Newmaster et al. 2006). Sequence data 42 

pertaining to the rcbL genes from many plant species are available through GenBank and we 43 
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will gather our data set from this resource. The rcbL gene sequence data will then be imported 44 

into MEGA, aligned, and then used to build a phylogenetic tree.  45 

Helpful Prior Knowledge and Potential Context of this Exercise: 46 

Students should have some introductory level knowledge of the purpose of evolutionary trees 47 

and have some experience interpreting simple phylogenetic trees. This exercise would be ideal 48 

as a final project for evolution units at varying levels, including AP Biology.  49 

Learning Objectives: 50 

By the end of this project, students will: 51 

1. Learn how to obtain molecular data from GenBank 52 

(http://www.ncbi.nlm.nih.gov/genbank/). 53 

2. Learn to build evolutionary trees using freely available software MEGA. 54 

3. Understand the meaning of ancestral vs. recent species, clades, and be able to 55 

interpret evolutionary relationship among species. 56 

As students perform the exercise, they should consider the following questions: 57 

1. Why was the rcbL gene used? 58 

2. Which organelle does the rbcL gene originate from? 59 

3. What function does the protein product of the rcbL gene have in the plant? 60 

System Requirements: 61 

1. Internet access to use the GenBank data base and to download MEGA. 62 

2. A text editor program, Notepad (Windows PC) or Texteditor (Linux/Mac).  63 

(http://www.megasoftware.net/mega.php) 64 

http://www.ncbi.nlm.nih.gov/genbank/
http://www.megasoftware.net/mega.php
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Getting Started: 65 

 66 

Figure 1. Google search for GenBank and click on the result for GenBank Home 67 

(http://www.ncbi.nlm.nih.gov/genbank/). 68 

 69 

 70 

Figure 2. Use the dropdown next to the word GenBank to change from default 71 

Nucleotide and select Gene. 72 

http://www.ncbi.nlm.nih.gov/genbank/
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 73 

Figure 3. Type RuBisCO large subunit in the entry box to the right of dropdown and click 74 

Search. 75 
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 76 

Figure 4. Select the link: rbcL for RuBisCO large subunit for a given species, here we will 77 

use Zea mays. 78 

 79 

Figure 5. Click on Genomic regions, transcripts, and products in the table on contents. 80 
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 81 

Figure 6. Click FASTA 82 

 83 

Figure 7. Copy the sequence of rcbL gene from Zea mays. 84 
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 85 

Figure 8. Paste the sequence data into a Notepad(PC) or Texteditor(Mac/Linux) 86 

(To find Notepad on a PC with Windows go to the Start menu, All Programs then click 87 

Accessories and you should see Notepad.) 88 
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 89 

Figure 9. After pasting into Notepad, leave the prompt sign > and delete text before the 90 

DNA sequence, then replace deleted text with Corn, the common name for Zea mays. 91 

 92 

Figure 10. Notepad should appear as shown above. 93 
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 94 

Figure 11. Save this file as corn.fasta and in the drop down choose All files (*.*). 95 

 96 

We now have the rbcL gene sequence for one species. We need to collect sequences for nine 97 

other species for comparison in MEGA (See Table 1). In addition, we will use Euglena viridis as 98 

our outgroup. Repeat the procedure with each species listed below by typing the GenBank 99 

Gene ID into the search box shown as shown in Figure 3. Make sure to select Gene to the right 100 

of the search box when searching by the Gene ID number. 101 

Table 1. List of plants from which the rcbL gene that can be used to create the phylogenetic 102 

tree, their GenBank ID numbers (Accession Numbers), and the suggested file names.  103 

Common name GenBank ID File name 

Corn 845212 corn.fasta 
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Thale cress 844754 thalecress.fasta 

Rice 4126887 rice.fasta 

Tobacco 800513 tobacco.fasta 

Potato 4099985 potato.fasta 

Liverwort 2702554 liverwort.fasta 

Sunflower 4055709 sunflower.fasta 

Grape 4025045 grape.fasta 

Cucumber 3429289 cucumber.fasta 

Spinach 2715621 spinach.fasta 

 104 

Obtaining the Outgroup: 105 

Euglena viridis will be used as the outgroup in our evolutionary tree. We will use the NCBI 106 

GenBank to locate the sequence for Euglena viridis. 107 



12 
 

 108 

Figure 12. Starting from GenBank Home we will select the Nucleotide search filter 109 

option to the left of the search box. 110 

 111 

 112 

Figure 13. Type U21010.1 into the search box and click search. 113 
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 114 

Figure 14. Click FASTA 115 

 116 

Figure 15. Copy the sequence and pate into a new Notepad file. Repeat steps in figures 117 

10 and 11. Save the file as euglenaviridis.fasta. 118 

Building the Evolutionary Trees: 119 
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The first step in the process of building evolutionary trees with this molecular data is to 120 

download MEGA and install it on the computers that are going to be used for the 121 

project. This tutorial features the latest stable version of MEGA at the time of print 122 

(http://www.megasoftware.net/mega.php).  123 

Instructions for using MEGA: 124 

1. Open MEGA.  125 

2. Click on Align then selected Edit/Build Alignment 126 

 127 

Figure 16. Click Edit/Build Alignment 128 

3. Create a new alignment. A secondary menu will appear that requires you to select an 129 

option. Choose Create a new alignment option and click OK.  130 

 131 

Figure 17. Select Create a New Alignment and click OK 132 

http://www.megasoftware.net/mega.php
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4. A second submenu will appear asking you to select the type of sequence data that will 133 

be used to build the alignment. Select the DNA option (Figure 18). This will open the 134 

MEGA Alignment Explorer in a new window (Figure 19). 135 

 136 

Figure 18. Click DNA 137 

 138 

Figure 19. Alignment Explorer opens 139 

5. At the top of the MEGA Alignment Explorer Window select the Edit menu by clicking on 140 

it. From this menu, select the Insert Sequence From File option (Figure 20). This will 141 

open a new window. 142 
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 143 

Figure 20. Click Insert Sequence from File 144 

6. In the window of the Open, select the .fasta data files saved earlier 145 

 146 

Figure 21. Select Supported sequence files 147 
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 148 

Figure 22. Select the .fasta files and click Open 149 

7. Once you have selected all of the files that you wish to upload, select the Open button 150 

by clicking on it.  151 

8. Once the sequences are loaded into MEGA, we want to align them. This is done by going 152 

to the Alignment menu at the top of the Alignment Explorer window. Click to open the 153 

dropdown menu and select Align by ClustalW by clicking on it (Figure 23). 154 
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 155 

Figure 23. Align By ClustalW 156 

9. This will open another window that is filled with ClustalW parameters. For our purposes, 157 

the default settings are adequate. Select the OK option at the bottom of this menu to 158 

proceed (Figure 24). This will set in motion the alignment algorithm. Aligning the 159 

sequences may take several minutes depending on the size and number of the 160 

sequences being examined. 161 
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 162 

Figure 24. ClustalW Parameters Dialog. Leave all set to their defaults.  163 

10. Now that the sequences are aligned (Figure 10), we may need to trim the ends of the 164 

sequences so that they line up nicely and do not contain too much excessive data. To do 165 

this, look for an asterisk (*) in the line above the first sequence in the Alignment 166 

Explorer window. At the first asterisk from the beginning of the sequences, use Click and 167 

Drag to select the nucleotides from there to the beginning of the sequences to be 168 

removed. (Figure 25). 169 
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 170 

Figure 25. Remove the Excess Nucleotides 171 

11. This process will need to be repeated for the tail ends of the sequences. Here find the 172 

last asterisk from the end, then Click and Drag to highlight the nucleotides to the end of 173 

the sequences. 174 

12. Now the sequences are aligned and trimmed (Figure 26). 175 

 176 

Figure 26. Sequences are aligned and trimmed 177 
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13. Now, we need to save the Alignment Session so that the data is saved in a format that 178 

MEGA can use to build the phylogenetic trees.  Save the Alignment Session by selecting 179 

the Data menu at the top right of the Alignment Explorer window. Click on the Save 180 

Alignment option. (Figure 27). After this has been completed and the session saved, 181 

close the Alignment Explorer window.  182 

 183 

Figure 27. Save Session 184 

14. Now, we need to open the saved alignment session by selecting the File menu in the 185 

general MEGA window and clicking on the Open a File/Session option (Figure 28). 186 

 187 

Figure 28. Open A File-Session 188 
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15. Select the saved alignment file (it will be a .MAS file) in the Open a File window and 189 

select Open by clicking on it (Figure 29). 190 

 191 

Figure 29. Click Open 192 

16. This will bring up a second window where you have the choice to open the .MAS to 193 

analyze it or align it. Select Analyze by clicking on it (Figure 30). 194 

 195 

Figure 30. Click Analyze 196 

17. To construct a phylogenetic tree, select the Phylogeny menu mid-way through the 197 

second menu bar at the top of the MEGA window. Here we will continue our example 198 
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with a Neighbor-Joining tree, but the process is the same for other types of phylogenetic 199 

trees.  Select Construct/Test Neighbor-Joining Tree (Figure 31). 200 

 201 

Figure 31. Construct-Test Neighbor-Joining Tree 202 

18. A menu will appear that asks if you want to use the currently active data sheet, select 203 

Yes (Figure 32). 204 

 205 

Figure 32. Click Yes 206 

19. This will open a dialogue box called Analysis Preferences. For the Statistical Method 207 

select Neighbor-Joining and for the Test of Phylogeny select Bootstrap Method. In the 208 

field entitled No. of Bootstrap Replications, select 1000 to obtain stable estimates of 209 

reliability of the tree. For the Substitution Type start by selecting Nucleotide followed by 210 

selecting the Jukes-Cantor Model. Here all other fields are left at their default values. To 211 

generate the tree, click on Compute (Figure 33). 212 
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 213 

Figure 33. Click Compute. 214 

20. After a few minutes, a tree will be generated. The length of time that this takes will 215 

depend in part on the length and number of sequences that are being used to create the 216 

tree (Figure 34). 217 

21. The numbers on the branches of the tree represents the Bootstrap value, which is the 218 

statistical support that each branch receives by the Bootstrap analysis. Higher numbers 219 

mean that the branch has higher support and is most likely to be a real branch (Figure 220 

34). 221 
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 222 

Figure 34. Generated Tree 223 

22. To simplify the tree, we now want to condense or cut out the branches that have less 224 

support and are less likely to be true branches. To do this, go to the Compute menu on 225 

the TreeExplorer menu and select Condensed Tree (Figure 35). 226 



26 
 

 227 

Figure 35. Select Condensed Tree 228 

23. This opens a new menu, Tree Options. Select the Cutoff submenu and input 50 for the 229 

Cut-off Value for Condensed Tree, then click OK (Figure 36). Leave all other values at 230 

their defaults. 231 
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 232 

Figure 36. Click OK. 233 

24. Now, the tree in the TreeExplorer will reflect the changes. All branches that have less 234 

than 50% support will have been removed. (See Figure 37) 235 

 236 

Figure 37. Condensed Tree 237 
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25. The last thing that we need to do is to set our out group. In our example here it is 238 

Euglena viridis. To do this, right click on the branch that has Euglena viridis. This brings 239 

up a submenu. In this submenu, select the Place Root option. This provides us with a 240 

rooted phylogenetic tree. (See Figure 38) 241 

 242 

Figure 38. Place Root 243 
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 244 

Figure 39. Euglena viridis as the Root 245 

The tree can be saved as a PDF or printed out. To save the tree as a PDF, go to the Image menu 246 

and select Export as PDF. A window will pop up and you can save the file there. To Print the 247 

tree, there is a Printer Icon that you can use just below the upper menu.  248 

Assessment Questions 249 

In order to ensure that students understand the output of this exercise, questions along the 250 

following lines may be asked: Which species are most closely related? Give an example of sister 251 

taxa. Why do you think that corn and rice are so closely related? How many base pairs were 252 

included in your analysis? How do you think the length of the gene sequence used affects the 253 

validity/reliability of your results? Why does the liverwort group with the outgroup? These 254 

questions, or similar, will let the instructor assess not only if the student has understood the 255 

process that they have gone through to create the phylogenetic tree, but in conjunction with 256 
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the questions that the students should consider as they build the tree, the student’s 257 

understanding of the process.  258 

 259 

Additional Background Information: 260 

The NJ and ML methods for building evolutionary trees rely on different statistical principles 261 

(Nei and Kumar 2000; Tamura et al. 2011). In NJ, the least squares method is used along with 262 

pairwise evolutionary distances (Nei and Kumar 2000). In ML, the maximum likelihood is 263 

optimized such that the inferred tree is the most likely tree (Nei and Kumar 2000). Generally, 264 

they will produce very similar results, but NJ is much faster. Despite slight differences in the 265 

branching patterns between NJ and ML trees, they both are robust methods for building 266 

evolutionary trees. The Jukes-Cantor model is simply a mathematical model that describes the 267 

change of one the nucleotides in the DNA sequence to another one, over time (Nei and Kumar 268 

2000). All of its parameters are automatically estimated by MEGA. 269 

Both NJ and ML produce trees that are unrooted, even though they are frequently drawn from 270 

left to right. In this case, if one knows the outgroup then it can be used to properly root the 271 

tree. Choosing a proper out group can be a difficult task and may require some trial and error 272 

(Nei and Kumar 2000). A good out group should be similar to the sequences in question, but 273 

different enough so that the computer program can see the differences (Nei and Kumar 2000).  274 
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